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2. Introduction 

SMART-HT is a windows based software, which supports Masibus HT16u device products. It provides 
true data collection and monitoring function; such collected data will be view in tabular, graph, zoom 
observation, and dynamic transfer to file without any need for annoying programming. 

 
Its unique concept combines three key functions (Configuration, Downloading Data and Reporting), 
which position SMART-HT as the most convenient solution. Software is design to streamline the 
process of downloading data and reviewing it in a user-friendly, time efficient manner. The software 
offers many customizable features and options, software includes reports, and displays like tabular 
and trend. 

 
The main requirements of 21 CFR Part 11 are data security, data integrity, traceability/audit trails and 
electronic signatures. Data security and data integrity are maintained by requiring users to login with a 
valid user name and password. There are then permission tables that delineate what a user has 
access to and what that user has the ability to do. Anything that is done with the data is logged to the 
audit trail, thus maintaining the integrity of the data. Capturing the – who, what, when, and why of data 
modifications is the requirement of the traceability/audit trails requirement. This data is captured 
automatically and includes the user name, the date and time, and what was modified. The data is not 
captured is why the data was modified. This data cannot be modified. It is all permanent and readily 
available in human readable format. 

 
SMART-HT meets the functional requirements for the use of electronic records and electronic 
signatures. 

 
The Masibus recommendations for the software architecture, conception, and configuration will assist 
users in achieving compliance. 

 
Thank you for choosing SMART-HT. 
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3. Software Installation Guide 

3.1 System Requirement 

Before you install the application, verify that you have at least the following. 

Hardware 

Computer Processor: Pentium III / Celeron 866 MHz (or equivalent) or later (32-bit) 

Recommended (Pentium 4M (or equivalent) or later (32-bit)) 

    Pentium 4 G1 (or equivalent) or later (64-bit) 

Memory:     1 GB RAM (recommended 2 GB) and 1.8GHz processor or better 

Hard Disk Space:  5 GB of available hard disk space 

Screen Resolution:   Resolution should be set at 1280 x 768 Pixels (recommended 1366 x 768) 

Color Palette:    Software contains 16-bit color graphics. It requires a minimum color palette                    

    setting of 16-bit color. 

Software 

Operating System:  Windows 10/8.1*/7 SP1** 

       Windows Server 2012 R2* 

       Windows Server 2008 R2 SP1** 
 

* Software installs VC2015 Runtime and .NET 4.7.1. Windows 8.1 and Windows Server 2012 R2 require 

Microsoft updates to support these items. Refer to Microsoft KB2919442 and KB2919355 for more 

information about how to install these updates. 

 

** Software is signed with a SHA-256 certificate. Windows 7 SP1, Windows Embedded Standard 7 SP1, 

and Windows Server 2008 R2 SP1 require Microsoft updates to support SHA-256. Refer to Microsoft 

KB3033929 for more information about how to install this security update. 

 

Additional Software Requirement:    

    Acrobat Reader 10 or higher version 
    Microsoft .NET Framework 4.7.1 or higher version required  
    Microsoft Visual C++ 2015(x86) Redistributable Package 
 

NOTE: The following list describes restrictions for using software on windows: 

 You cannot access software using a guest account on windows. 

 Although the software is designed to work with the windows operating systems listed above, 

software cannot guarantee operation on OS’s no longer supported by Microsoft support life 

cycle policy. 

 If Windows Update is enabled, the installation process might hang if Windows Update 

interferes with the installation of Microsoft Visual C++ Redistributable Package. 

 If you purchased this software, use the installation media that shipped with your purchase to 

install this software. 

 Software does not support and will not install or run on windows 2000 / NT / Me / 98 / 95 / XP 

/ windows vista / Windows 7 RTM (with no service pack). 
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3.2 Steps to install SMART-HT 

1) Installing SMART-HT Software 

 To install the software from a drive, insert the installation source disk into the CD drive, 

setup.exe file is available in the Setup\Volume\ directory as shown in below image. 

 Before starting the software installation, you must be logged in as a user with administrative 
privileges for installing and configuring software applications. Make sure that no other 
programs are running, save your work, and close any open applications. 

 

 

 Double-click the setup.exe (application) to launch the installer options, when the installation 
welcome screen appears, click Next for the installation directory screen. The user can change 
the installation folder, if required. It is recommended to keep it at the default and then click on 
the Next. 

         

 Installer will appears masibus and national instruments software license agreements. Read 

the license agreement and accept it. 
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 When accepting both the license agreement respectively, click on the Next twice and start the 

installation as shown in next screen 1. The following dialog box will appear when the software 

has been successfully install as shown in screen 2. 

      

 

 Soft Dog USB Driver and Microsoft .NET Framework 4.7.1 are install by default with the 

Standalone installation of SMART-HT if no such instance is detect during the installation. 

 

 

2) Installing Soft Dog Driver - Click on 

Next, SMART-HT License Hardware Key 

driver installation window will appear. It is 

recommended installing driver for license 

key. 

NOTE: User need to select USB Dog 

driver (for USB Port in PC) OR Parallel 

Dog   Driver (For Parallel Port in PC). 

After selecting proper driver click on the 

Install Driver, it will start the installation, 

when installation is completed driver 

installation, status window will appear, 

click Exit. 

 

 

 

3) Installing Microsoft .NET Framework 

4.7.1 

Now driver installer setup will install .NET 

Framework 4.7.1. User need to select 

OK to install .NET Framework or Cancel 

to discard. 

 

 

 If the .Net 4.7.1 Framework has already been installed and you attempt to run the install .Net 

4.7.1 Framework, a window asking to repair or remove the .Net 4.7.1 Framework will appear. 

It is recommended select the Cancel button when this page appears. If the higher version 

of .NET Framework is present in the client PC, then it will automatically proceed to the next 

level OR may be promote as a warning as shown. It is recommended select the Cancel 

button when this page appears. If user click OK button, setup will execute and extract to a 

suitable place. 
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 Installer will appears Microsoft software license term. Read the license, accept it, and click on 

Install. When the Installation Is Complete screen appears, click Finish to exit the wizard.

 

        

 

 

 

 You may be prompt to restart your 

computer dialog box when the 

SMART-HT software have been 

successfully install. Click on the 

Restart. It is recommended to restart 

your system after installation to 

updates a DLL that is loaded in one or 

more processes that are required by 

Windows or makes changes to the 

registry. 
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4. Basic Operation 

This article explains the basic operation of software along with the procedure of data acquirement. 

4.1 Starting the Software 

To begin, launch the software by simply double clicking 

the desktop icon, or clicking the icon in the All Programs 

in the Start Menu. If application shortcut will not show 

as below with administrator access, you have to right 

click on it if you use a mouse and keyboard device. If 

you use a touchscreen, just press on the shortcut and 

hold. You should be able to see, an option 

 that allows you to run as 

administrator. If you run the application from an account 

without administrator permissions, the UAC prompt will 

ask you to enter the administrator password. If you do 

not provide the password, the program will not be 

launch.  

 

4.1.1 Startup Screen 

 Startup screen will display current 
version of the software. The second 
figure shows the SMART-HT in the 
windows toolbar. Once the software is 
open, the user can make all 
preference changes that are 
necessary. 
 

 

 
 
4.1.2 User Login 

 On starting software, following Login To Access screen will be display (from shortcut). Users 
who fail to authenticate within 60 seconds, the timeout period expires, and the user is allow 
retrying authentication by again launch the software as discussed above or click on shortcut. 
Enter correct Username and Password, press Login to go to the main screen. Press Close to 
exit from the SMART-HT if software launch.  
 

 Default Username and Password - Admin. 
 

 On first login user need to change their password with required minimum complexity. 
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 If windows cannot access database by any of the reason as if the database folder has not 
been set up for read/write access to the user (access permission denied), database cannot 
access, this problem is most likely related to access rights provided to database converter by 
your operating system in such cases the error message should display. 

 

 If the user does not have an active account or permission and if account is blocked then 
the following message should display. To login the user must have active account with 
necessary access rights. 
 

       

 If user account password will be expiring, within next 10 days it will shows notification 
message on particular user login and every day at 10:00 am until the password is changed or 
expired. The user account is block after a specified number of consecutive failed login 
attempts. 
 

        
 

 User should be auto logout if remain idle for defined time interval, the data monitoring will be 
continue after user logout. To make change or access software user need to login and will 
only access those features of software, which will be assign to their user groups. 
 

 The detailed user account features will be explain later in the user management section. 
 

4.1.3 Getting Started 

 After enter correct username and password user will redirect to following main screen if 

software is launching, user access software as per there access rights assigned. Each 

section of the software will be explain briefly in the following pages. Users with assigned 

access control level can configure initial setup or make necessary changes. 

 

 Software will run in following two modes 

1. Demo: This is a free version of software without data export features. 

2. License: Using USB flash drives, a software protection dongle (commonly known as 

a dongle or key) to access-licensed version of software with data export features. 

 

 Thank you for purchasing SMART-HT. This getting started guide describes how to use 

SMART-HT. This article describes the simple systematic procedure for initially preparing 

the software with your host computer. 

Note: An alternative way to make sure the key’s serial number is correct is to roll mouse on 

License info taskbar. The program will show tip tool with all information of key, which will, 

attached to the computer via the USB interface as shown below. 

 

http://en.wikipedia.org/wiki/USB_flash_drives
http://en.wikipedia.org/wiki/Dongle
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4.2 Menus and Toolbar 

Within the first upper tab titled, many different options appear. Below is a brief description of 
every item. 

 

4.2.1 File Menu 

 The File Menu offers following commands.

Open 

 Use this command to open the previously saved device configuration from the file. It includes 
the Device Information, Logging, Temperature and Humidity Set Points value. 
 

       
 

Save 

 You may save the configuration you 
have as a file. This configuration file 
can be use in the future with a single 
click. This allows you to load device 
settings and quickly download with the 
same settings in multiple device. 

 
 
 
 

Backup 

 Use this command to backup data, the result of copying or archiving files and folders for the 
purpose of being able to restore them in case of data loss. Many things ranging from 
computer viruses to hardware failures to file corruption to fire, flood, or theft (etc.) can cause 
data loss. Software backup features will take batch data backup. It will overwrite to the 
existing data of selected backup folder if exist. 
 

 There are two option to backup data, when user click on command following option window 
will appear as shown in image 1. NOW will redirect to select path where user need to store 
data. Just select folder path and backup process will start. SCHEDULE will redirect to 
schedule backup window where user can configure required details as shown below and save. 
At Hours Starting, time of Backup Every Day It will take silent auto backup data to selected 
path.  
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Restore 

 Use this command to backup data will restore again to SMART-HT, the process of copying 
backup data from secondary storage and restoring it to its original location. Several 
circumstances lead to the need for a 
data restore. One is human error, 
where data has accidentally deleted or 
damaged. Other circumstances include 
malicious attacks where data is 
exposed, stolen or infected; power 
outages; manmade or natural disasters; 
equipment theft, malfunctions or 
failures; or firmware corruption. Data 
restore features will replace to the 
existing data in SMART-HT if exist. 
 

 When user click on command following 
window will appear as shown in image 
to select backup folder, after it will 
redirect to restore data.

 

Exit 

 Use Exit button to end your session.                  

 This action will terminate all services associated with SMART-HT software. When user clicks 
on exit, first it will ask for the login password (Access password). 
 

 Access password - To prevent from 
unauthenticated users, some critical 
configuration, and exit needs to enter login 
password to access this functionality. When 
user enter correct password, it will close the 
application. 

 
 

4.2.2 Edit Menu 

 The Edit Menu offers following commands. 

Settings 

 Use this command to edit the details of the Company Name and Logo path, which will be print 
in the report. Time format for View, Report and Trend in 12 and 24-hour format. 
 

http://searchstorage.techtarget.com/definition/secondary-auxiliary-storage
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Reset Min/Max 

 Reset Min/Max allows you to set the minimum and maximum value of device to current value. 
This action will clears min-max value of respective sensor display from data-logger. After min-
max reset data-logger start sorting new fresh Min & Max value from sensor. 
 

4.2.3 User Menu 

 The User Menu offers following commands.

Profile Settings 

 When login user want to change their password , click on the Profile Settings, below window 
will appear. Now enter the Old password and New password . Enter the same password in 
the Confirm password box which you have enterd in the New password box. Now click on the 

SAVE to change the password. User must meet password complexity requirements.  
 User can not reapet their last 10 used passwords. 

 

The password contains characters from three of the following categories with minimum eight 

characters: 

 Uppercase letters of European 

languages (A through Z characters) 

 Lowercase letters of European 

languages (a through z characters) 

 Base 10 digits (0 through 9) 

 Non-alphanumeric characters (special 

characters) (for example, !, $, #, %). 

 

User Accounts 

 Only administrator user has the access rights to view and update the user details. When click 
on User Accounts menu, user can view the following screen. 
 

 
 

 User can view details of existing user accounts, create new user accounts, edit or delete any 
user accounts. 
 

 User can create maximum 1000 user accounts and assign different access levels user groups 
like administrator, maintenance, manager, supervisor or operator to those accounts. 
 

 Accounts have facility to configure Lockout Try, Account Expiry and Automatic Logout time as 
discussed earlier in login section. In addition, you can assign individual E-signature to user 
accounts as shown below which will be use at time of report / trend data export.  
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 Software provides an implementation of two distinct identification components such as a 
unique combination of user name and password for users with assigned electronic signature. 
In SMART-HT, the first signings always performed by the two identification components (user 
name/password) and all subsequent signings performed using one identification component 
(pincode).  

 

 It is strongly recommend that the end customer shall prohibit the use of an individual's 
electronic signature by anyone other than its genuine owner. Password data cannot be 
retrieve from the software. 
 

      
 

 Since an administrator account is required to create other user accounts, you are assure to 
have at least one administrator account in your software. 
 

 The Administrator account has full control of the software and can assign other user access 
rights as shown in below image. The user accounts with user groups can only access those 
features of software for which the user groups have access rights. 

 

 User can manage MEANING list 
which will be used while sign the 
report documents, when user click on 
button following window will open. 
User can create or delete meaning as 
per requirement. 
 

      

4.2.4 System Menu 

 The System Menu offers following commands.
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Lock 

 System Lock allows you to lock your desktop so that no other users may use your computer.  

 
Unlock  

 System Lock will lock straight away and when the click on this command and enter correct 
password, it will unload itself from memory. 

4.2.5 Tools Menu 

 The Tools Menu offers following commands.

Calculator 

 Use this command to open the Calculator form SMART-HT software to do some calculation 
regarding values of incoming data. 

Notepad 

 Use this command to open the Notepad form the SMART-HT software to write and store 
something related to data and trend. 
 

4.2.6 Connect Device 

 By clicking this command user can start and stop communication with device. 

 You need to start communication on different occasions as follows: 
 Retrieve batch data from device. 
 Logging need to be start or stop in device. 
 Device time modified. 
 Modification required in device settings. 

4.2.7 HT16u Time 

 By clicking this command user can upload and download device time. User can select time 
OR direct download system time by select 
check on left side in time stamp.  

4.2.8 Device Configuration 

 By clicking this command user can upload and download Device Information, 
Logging, Temperature and Humidity Set Points in connected device. User need to select and 
check individual parameters to download and select individual group to upload the 
configuration. 

4.2.9 Retrieve Batch Data 

 This feature is allow to upload logged data from device. The uploaded data will be available in 
Data Report and Trend until not deleted permanently by user. 
 

 The data is stored with Device ID and Batch ID combination; if already data exist then 
software give an option to skip OR delete present data (delete feature is only accessible by 
administrator user). 
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4.2.10 Audit Report 

 This report is create for all audit data for selected time interval.  
 

 The Audit Report wizard window will pop up as below using Audit Report wizard.  An audit 
trail (also called audit log) is a security-relevant set of records that provide documentary 
evidence of the sequence of activities that have affected at any time a specific operation, 
procedure, or event. You have to select the time interval to viewing, print or exporting the 
data. A report can be export to a file in the internal hard disk. User can filter out audit data by 
selecting proper filter value. 
 

 

4.2.11 Logout 

 Use this command to end your session.                   

 This action will terminate all access rights associated with user account. User need to logging 
to access SMART-HT software. 

 

4.2.12 Demo 

 SMART-HT application software has been license with a hardware key. However, 
the application can be use without a hardware key in a demonstration (Demo) mode, which is 
limited to block data export functionality. The screen similar to the following, you can see that 
demo in the right pane as well as in toolbar info too. 

 

 

4.2.13 System Time 

 System date and time represents a computer system's notion of the passing of days and time 
on the calendar. 

4.2.14 Operate 

 This menu is reserve for future use. 

4.2.15 Help 

 The Help Menu offers help command; use this command to view user guide, features and 
functionality of SMART-HT software. For further information described in this manual, please 
contact at support@masibus.com. 
 

 
 

 

http://en.wikipedia.org/wiki/Calendar_date
http://en.wikipedia.org/wiki/Calendar_date
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4.3 Task Bar Information 

The frequently used information are prepared in Task Bar.  It contains mainly Communication Status, 
Licensing, Login details and PC Key Status. 

 

 
 
 Communication Status: On the status bar, a text indicates its health status; Good shows 

SMART-HT communicating with devices where Error shows there is an error while Hold 
shows no communication initiated by user. 

 

 Software License: It will display software license information, "Licensed" in the info bar. 
 

 Login User Details: It shows the login Username detail. 
 
 Caps Lock Status: Caps Lock is a button on a keyboard that changes if a letter should be 

capitalize or not. It is located in the position of a similar Shift lock key (and sometimes a Ctrl 
key) found in some other keyboard layouts. 

 
 Num Lock Status: Num Lock or Number Lock is a key on the numeric keypad of 

most computer keyboards. It is a lock key, like Caps Lock and Scroll Lock. Its state (on or off) 
affects the function of some of the keys, and is commonly displayed by an LED built into the 
keyboard. 

 
 Scroll Lock Status: Scroll lock is a lock key (typically with an associated status light) on 

most IBM-compatible computer keyboards. Depending on the operating system, it may be 
used for different purposes and applications may assign functions to the key or change their 
behavior depending on its toggling state. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://en.wikipedia.org/wiki/Numeric_keypad
http://en.wikipedia.org/wiki/Computer_keyboard
http://en.wikipedia.org/wiki/Lock_key
http://en.wikipedia.org/wiki/Caps_Lock
http://en.wikipedia.org/wiki/Scroll_Lock
http://en.wikipedia.org/wiki/LED
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5. SMART-HT Trend 

SMART-HT provides two types of display for data view. These are trends and tabular. A trend log is a 
collection of time-stamp values. A trend type display is used for bar or line graph for one or more 
parameters. 
 

 
 
 Display Properties - Display properties are specifies for each individual sensor. By default, 

software assigns a separate color to each of the sensor and all other properties are same. 

 
 Auto Scale Axis (Locking the Vertical Scale of a Graph) - You use the auto range function 

to automatically adjust the trend y-axis according to the range of the series displayed. The 
vertical scale of a graph can be lock to prevent any automatic adjusting from occurring when 
zoom-in OR zoom-out. Any values that lie outside the displayed range will not resize the 
graph view. 
 

 To navigate in the trend in small steps, you scroll the x-axis in steps equal to the displayed 
page of the trend. 

 

 By double clicking on batch, from tree menu user can select or remove batch to view data in 
trend as shown below. The red color indicates selected batch data. You can zoom in to 
enlarge the scale of the trend to make the reading easier. 

 The trend contains many tools for easy navigation in the chart. You can scroll or use the 
predefined settings to focus on the time span you want to see. 
 

 You can export/print a trend chart using the Export button. 
 

 Minimum, maximum, average and MKT values are calculations based on the recorded data 
for that parameter for selected time only. 

 
 User also Save and Load trend custom configuration settings at any time as shown in above 

trends. Up to six such configuration settings can be save. When user can make there custom 
configuration in trend, click on Save button the trend file selection window will open. While 
click on Load button and select file to apply previously save configuration. The Default option 
will set configuration settings to factory default. 
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6. SMART-HT Report 

SMART-HT report is use for displaying and exporting archived batch data. No database server, no 
SQL programming, no report designer but still you have all those reports. 
 

 The Data Report wizard window will pop up as below using Data Report wizard.  You 
have to select the batch to viewing or exporting the data. A report can be export to a file in the 
internal hard disk. User can export report in PDF file. User also directly print report data from 
software. 

 

 
 When data print OR export, it will ask to sign documents, on confirmation it will promote 

available e-Sign list and Meaning. User also insert additional comment if any as shown in 
image 1.  

 

 Access password - To prevent from unauthenticated users, it needs to enter user name and 
e-sign pincode to access this functionality shown in image 2. When user enter correct 
password it will sign document as shown in image 3 at bottom of report page. 
 

         

 
 

 

 Alarm Report 
This menu is reserve for future use. 
 

 The Alarm Report wizard window will pop up using Alarm Report wizard.   
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7. Software License Agreement 

Software License Agreement the following License Terms govern your use of the accompanying 
Software unless you have a separate signed agreement with Masibus Automation And 
Instrumentation Pvt. Ltd. (www.masibus.com) 
 
SOFTWARE LICENSE NOTICE TO ALL USERS: CAREFULLY READ THE FOLLOWING LEGAL 
AGREEMENT ("AGREEMENT"), FOR THE LICENSE OF SPECIFIED SOFTWARE ("SOFTWARE") 
BY Masibus Automation And Instrumentation Pvt. Ltd. (“Masibus” “Our” OR “We”). BY USING 
THE SOFTWARE, YOU (EITHER AN INDIVIDUAL OR A SINGLE ENTITY) ACKNOWLEDGE THAT 
YOU HAVE READ THIS LIMITED WARRANTY, UNDERSTAND IT, AND AGREE TO BE BOUND BY 
ITS TERMS AND CONDITIONS. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS 
AGREEMENT, DO NOT INSTALL, ACCESS OR USE THE SOFTWARE. (IF APPLICABLE, YOU 
MAY RETURN THE PRODUCT TO THE PLACE OF PURCHASE FOR A FULL REFUND.) 
 

LICENSE GRANT 
Subject to the payment of the applicable license Fees followed by the activation of software from 
Masibus, and subject to the terms and conditions of this Agreement, We are pleased to grant you a 
personal, non-exclusive, non-transferable right to use the Software and the accompanying 
documentation (the "Documentation"), if you follow all restrictions in all sections of this agreement. 
This license is edition specific, which allows or restricts the use of different options/features based on 
the purchased or complementary edition. Except as set forth below, you may only install one copy of 
the Software on one computer, workstation or other electronic device for which the Software was 
designed (each, a "Client Device"). “Software” means (a) all of the contents of the files (delivered 
electronically or on physical media), or disk(s) or other media with which this agreement is provided. 
“Use” or “Using” means to access, install, download, copy, or otherwise benefit from using the 
functionality of the Software. If you accept the terms and conditions of this Agreement, you have 
certain rights and obligations as follows: You may: 

1. Install and use the Software on any number of computers. 
2. Make a copy of the Software for archival purposes, if required. 

 
TERM 
This Agreement is effective for an unlimited duration unless and until earlier terminated as set forth 
herein. This Agreement will terminate automatically if you fail to comply with any of the limitations or 
other requirements described herein. Upon any termination or expiration of this Agreement, you must 
destroy all copies of the Software and the Documentation. You may terminate this Agreement at any 
point by destroying all copies of the Software and the Documentation. 
 
UPDATES 
Masibus may provide free upgrades to the latest version of this software via its web site or through 
other online OR offline services. At our discretion, we may charge an upgrade fee for new releases, 
which contain significant enhancements. 
 
OWNERSHIP 
Title, ownership rights, including all copyrights, patents, trade secret rights, trademarks and 
intellectual property (the Software and any authorized copies that you make) rights of the Software 
shall remain with Masibus. Copyright laws and treaties protect this Software. Your possession, 
installation, or use of the Software does not transfer to you any title to the intellectual property in the 
Software, and you will not acquire any rights to the Software except as expressly set forth in this 
Agreement. 
 

 
RESTRICTIONS 
You do not have any right to reproduce or distribute the Software without our permission; any such 
unauthorized use shall result in immediate and automatic termination of this license and may result in 
criminal or civil prosecution. You may not:  
1. Reverse engineer or otherwise try to derive source code from the Software. 
2. Adapt or modify the Software or create derivative works based on the Software. 
3. Publish copy (other than backup copies), rent, lease, loan, resell, sublicense, assign or in any 

other way transfer the Software to anyone else. 

http://www.masibus.com/
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4. Use the Software in any manner not authorized by this license. 
5. Transfer any of the rights granted to you under this Agreement. 
6. Remove or alter any trademark, logo, copyright or other proprietary notices, legends, symbols 

or labels in the Software. 
 

DISCLAIMER OF WARRANTY 
This software is provided "AS IS" and it is essentially capable of carrying out the functions specified in 
the documentation, provided it is used with the recommended operating system and the hardware 
configuration. Masibus disclaims all warranties, either express or implied, including but not limited to 
implied warranties of merchantability, fitness for a particular purpose, and no infringement with 
respect to the software and the accompanying documentation. You expressly acknowledge and agree 
that use of the software and any third party software and services is at your sole risk and that the 
entire risk as to satisfactory quality, performance, accuracy and effort is with you. It is at your own 
discretion and risk that you download and/or use the software. You will be solely responsible for any 
damages to your computer system or loss of data that results. Masibus makes no warranties or 
representations that the functions contained in the software will meet your requirements that the 
operation of the software will be uninterrupted or error-free, or that defects in the software will be 
corrected. 
  
LIMITATION OF LIABILITY  
 
Under no circumstances shall Masibus or its affiliates (including suppliers, resellers, or partners) or 
their respective executives, employees, shareholders or contractors be liable for personal injury, or 
any incidental, special, direct or consequential damages whatsoever, including without limitation, 
damages for loss of profits, loss of data, business interruption or any other commercial damages or 
losses, arising from or related to your use or inability to use the software or this agreement, however 
caused, regardless of the theory of liability (contract, tort, or otherwise) and even if any such party has 
been advised of the possibility of such damages. In no event shall ‘Masibus’, or it’s affiliates’, total 
liability to you, for all damages exceed the amount, if any, paid by you to Masibus for the software 
and/or services prior to the event which gave rise to the damages in question. If the software and 
services are provided without charge, then there shall be no liability to you whatsoever. The foregoing 
is your sole and exclusive remedy for any breach. This limitation of liability shall not apply to liability 
for death or personal injury to the extent that applicable law prohibits such limitation. Furthermore, 
some states and jurisdictions do not allow the exclusion or limitation of incidental or consequential 
damages, so this limitation and exclusion may not apply to you. This limitation of liability for personal 
injury or exclusion of incidental, consequential, or direct damages, will apply only to the extent 
permitted under applicable law. The disclaimers and limitations set forth above will apply regardless of 
whether or not you accept the software, updates or upgrades. 
 
MISCELLANEOUS 
Masibus reserves the right to change the terms of this Agreement at any time without making those 
changes retroactive to past releases. 
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8. Contact Information 

For further information described in this manual, please contact at Masibus Automation And 
Instrumentation Pvt. Ltd. by phone or email: 
 
B-30, G.I.D.C Electronic Estate, Sector - 25, Gandhinagar - 382044. Gujarat - India. 
Phone: +91 79 23287275-79 
Fax: +91 79 23287281 
E-mail: support@masibus.com 
 
 


